Welcome to Exchange Unified Messaging. This system will replace MCC’s existing Audix voice mail system and provide additional functionality. Microsoft® Exchange Server is the engine that powers Outlook but it also provides new and convenient ways to access voice mail. Now your e-mail and voice mail messages are placed into one mailbox that can be accessed through many different devices such as a telephone, mobile phone, or computer.
# Table of Contents

INTRODUCING UNIFIED MESSAGING VOICEMAIL .................................................................................................................. 3

TYPES OF VOICEMAIL BOXES ................................................................................................................................................... 4

- Individual Voicemail Users ................................................................................................................................................. 4
- Shared Departmental Voicemail Users ............................................................................................................................. 4
- Departmental Voicemail Users.......................................................................................................................................... 4

HOW TO ACCESS YOUR VOICEMAIL ........................................................................................................................................ 5

- First Time Set Up From A Phone ............................................................................................................................................ 5
- Access Your Voicemail From A Phone .................................................................................................................................... 5
- Access Your Voicemail from Outlook ..................................................................................................................................... 6

MANAGING VOICEMAIL OPTIONS THROUGH OUTLOOK WEB APP .............................................................................................. 8

- Accessing Voice Mail Options through Outlook Web App ........................................................................................................ 8
- Accessing Voice Mail Options through the Outlook 2010 for Windows ..................................................................................... 8
- Reset PIN ....................................................................................................................................................................................... 8
- Greetings ......................................................................................................................................................................................... 8
- Outlook Voice Access ....................................................................................................................................................................... 8
- Voice Mail Preview .......................................................................................................................................................................... 8
- Notifications .................................................................................................................................................................................... 9

FREQUENTLY ASKED QUESTIONS ........................................................................................................................................... 10
INTRODUCING UNIFIED MESSAGING VOICEMAIL

This is the final phase of our Telecom Upgrade project. Information Technology Services has been working over the past few months to ensure all necessary systems are in place prior to completing the launch of our new voice mail system College-wide.

The new voicemail system is part of Microsoft® Exchange Unified Messaging. Beginning September 27, 2015, voicemail will be delivered to your existing mailbox and instructions will be provided for accessing and using the new system.

Unified Messaging offers a combined inbox for your email and voicemail with speech commands that let you:
- Read a transcription of your voice messages from your inbox with speech to text
- Listen to your voicemail as well as your email and calendar items over the phone with text to speech
- Search for contacts and send them messages
- View missed call information

This guide is meant to be a tool to show you both the basic and advanced functionality of the voicemail portion of this communication platform.
TYPES OF VOICEMAIL BOXES

Individual Voicemail Users
This is the most common type of mailbox. After your Exchange mailbox and your telephone number have been enabled for Unified Messaging Voicemail you will receive a welcome email from Microsoft® Outlook containing:

- The telephone number to access voice mail.
- Your extension number
- Your first-time PIN

Shared Departmental Voicemail Users
A shared departmental voicemail box is set up for situations when more than one person manages the messages. The shared departmental voicemail box must be attached to an email address so that both email messages and voicemail messages are captured in the same account.

Setting up a departmental voicemail box requires coordination between all the individuals who have access because one person will need to record the name and greeting as well as change the PIN. Once these steps are taken the departmental voicemail can be managed entirely through Outlook. However, the PIN should be communicated to all users who need access through the telephone.

Departmental Voicemail Users
This is a mailbox that is attached to a phone number that gives callers the choice of pressing 1 to speak to individual A, pressing 2 to speak with individual B, etc. This arrangement requires more planning and programming. If required, you will be contacted for the initial setup requirements. If you need to make changes to the initial mailbox setup you should contact the Service Desk at x3301.
HOW TO ACCESS YOUR VOICEMAIL

First Time Set Up From A Phone

Before you begin setting up your voice mail greeting, you will need to know your PIN. Your PIN will be sent to you in an e-mail message from Microsoft® Outlook. The first time you dial into your mailbox you will be asked to set up your greeting and name identifier. It is good customer service and phone etiquette to record a personalized greeting.

1. Press the Message button on your desk phone or dial the access phone number: x3232, or from off campus 978-656-3232.
2. If you are not calling from your office phone, you will need to enter your 4 digit extension. The automated system will pronounce your name.
3. Enter your PIN and press#. You will be asked to change your PIN#. It must be at least 4 digits and due to the increased access with Unified Messaging, the PIN must be changed at least every 365 days.
4. Follow the prompts to record your name in your own voice. This will serve as identification to you callers. (If you don’t record your name, a the text recognition program will be attempt to interpret it for you.)
5. Follow the prompts to record a personal greeting which will be played to callers when you are not able to answer. You can always change this later. (If you don’t record a greeting, a standard greeting will be played.)
6. The first site setup is complete when you hear the system say: "Your voice mail has been set up. Please say voice mail, e-mail, calendar, personal contacts, directory or personal options."

Access Your Voicemail From A Phone

1. Press the Message button on your desk phone or dial the access phone number: x3232, or from off campus 978-656-3232.
2. You will hear your name and a request for your PIN.
3. Enter your PIN and press#. Then you will hear something similar to: "You have 3 new voice messages, 4 new e-mail messages, and your next meeting is at 9 A.M. Please say voice mail, e-mail, calendar, personal contacts, directory or personal options."
4. Say "Voice Mail".
   **Tip:** At any time, you can switch to a touchtone interface and use the telephone keypad rather than speaking by pressing "0".
5. The system will open your mailbox and play the voice mail messages. Here are a few useful voice commands while listening to your voice mail:
   - "Next" Plays the next voice mail message
   - "Previous" Plays the previous voice mail message
   - "Delete Message" Deletes the current voice mail message
   - "Forward" Forwards the voice mail to another user
   - "Faster" Plays the current voice mail message faster
   - "Slow down" Plays the current voice mail message more slowly
   - "Pause" Pauses the current voice mail message
   - "Repeat" Repeats the current voice mail message
   - "Main Menu" Exits to the main menu

**Tip:** If you delete a voice mail message here, you won’t be able to undelete the message using the telephone, but you can still access it in the Deleted Items folder in Outlook.
Access Your Voicemail from Outlook

With Exchange Unified Messaging, all voice mail messages are delivered directly to your existing Outlook Inbox and can be played through the computer speakers, headphones or on your phone. Exchange Unified Messaging offers one convenient place to manage e-mail and voice mail with new options such as forwarding voice mail with comments or attachments just like a regular e-mail message.

1. Open Outlook. Voicemail and missed calls will appear in the Inbox folder along with your email.

2. Double click on the message (or view the reading pane) and you will see an integrated Microsoft® Windows Media Player.

3. Simply click on the Play button and listen to the message through the computer speakers.

Edit Notes: You may add comments for yourself in the Audio Notes box. If you forward the message to someone else the notes go with the message.
Play on Phone Feature

If you want to listen to your messages on your desk phone and not through your computer speakers you can click on the “Play on Phone” button.

The first time you use this feature you will be prompted for credentials and your 4 digit office phone number.
MANAGING VOICEMAIL OPTIONS THROUGH OUTLOOK WEB APP
The best way to manage your voicemail options is through the Outlook Web App (OWA), which you can access directly via the web at https://mymcc.middlesex.mass.edu or through the File tab of Outlook 2010. From OWA you can reset your PIN, select Greetings, manage your Voice Access, specify your Play on Phone settings, choose your Voicemail Preview preferences, and specify your notifications.

Accessing Voice Mail Options through Outlook Web App
1. Login to https://mymcc.middlesex.mass.edu and click Email.
2. Click the Options button and select See All options.
3. From the left-hand menu click the Phone link.

Accessing Voice Mail Options through the Outlook 2010 for Windows
1. From the File tab, click on the Info button.
2. Select Manage Voice Mail (at the bottom of the page).
3. This will send you to OWA to continue managing your Voicemail.

Reset PIN
1. Click the Reset my voice mail PIN... link and verify you want to reset your PIN in the dialog box that appears.
2. An email containing a new temporary PIN will be sent to your inbox.

Greetings
1. Click on a radio button to select the desired greeting option.
2. Click Call Me to play or record the selected greeting to listen to and/or change your greeting.
3. Be sure to save your settings by clicking Save at the bottom of the page.

Outlook Voice Access
These options are for when you access your mailbox via a telephone. You can change the order in which new voicemails are played and choose which email folder is accessed when you call for your email.

Voice Mail Preview
Unified Messaging in Exchange will transcribe voice messages to text. The transcription will be a best attempt. Typically the transcription isn’t 100% accurate but it’s usually enough to get the meaning of the message (and sometimes a good laugh). You can turn this functionality off here if you wish. The first option is to provide the transcription on any voicemail that you receive. The second option is to provide the transcription on any voice messages you send. Be sure to scroll to the bottom of the page and click Save to save your settings.

Tip: You may have a better experience with Voice Mail Preview when you don’t try to read the preview too carefully, word by word. Instead, look for names, phone numbers, and phrases such as “Call me back” or “I need to talk” that may provide enough information to determine the purpose of the call.
Notifications
You can choose to receive a notification in your inbox when you miss a phone call and the caller does not leave a message. You can disable that missed call notification here. Be sure to scroll to the bottom of the page and click Save to save your settings.
FREQUENTLY ASKED QUESTIONS

• Will the messages and greetings I have saved in my old voicemail box automatically be moved to Unified Messaging in Exchange when my voice mail is transitioned?

No. Saved voice mail messages and recorded greetings will not be migrated to Exchange. Additionally, old voice mail messages cannot be forwarded to Exchange voicemail mailboxes.

• My department uses a "menu mailbox/Auto Attendant" that answers calls with a recorded greeting which prompts users to press 1 to leave a message for John, 2 to Talk to Jane, etc. How will Auto Attendant mailboxes be transitioned to Exchange Voice Mail?

Auto Attendant mailboxes will be transitioned to Exchange Voice Mail using a Voice Mail Only account that has rules associated with it to create the menu options. The Service Desk (Network & Telecom Group) will assist users with transitioning menu mailboxes to Exchange Voice Mail. If you have questions about an Auto Attendant mailbox used by your department, please contact the Service Desk at x3301 or at servicedesk@middlesex.mass.edu.

• Can I set up an out of office message on my phone via email?

No, you cannot set up an out of office message for your voice mail through your outlook email. This needs to be done by calling in using Outlook Voice Access (x3232 or 978-656-3232).

• I forgot my PIN do I need to call the Service Desk to get it reset?

No, the Service Desk is not able to reset PIN numbers for voice mail. You must reset the PIN yourself. In OWA click the Options drop-down and select See All Options.... Then select Phone from the left menu and you can reset your pin there.

• What number do I call to get my messages?

Dial x.3232, or 978-656-3232 from off campus to access your voice mail.

• What can I do if I deleted a message in email, and now I can’t play it on my phone or I deleted a message on my phone, and now I can’t find it in my email?

When you delete a message, either on your phone or in your e-mail, it is moved to the Deleted Items folder. You cannot access your Deleted Items from the phone, but you can still access the message in your Deleted Items in Outlook.

• That text preview makes no sense to me; how can I turn it off.

You can modify your text preview settings using the directions under “Voice Mail Preview” earlier in this document.

• I missed a call. Why does it not dial the number when I click on it?

A missed call notification is sent when a caller hangs up after your greeting begins to play, but before leaving a message. The notification includes the caller's phone number. If that number is in your Outlook contacts, you can click on the number to send an email to the email address associated with the number. In no case will clicking on the number dial the number.

If you don't want to receive notifications of missed calls, you can change your Notifications setting to no longer send them.

• I want someone to be able to check my voice mail, but not my email. How can I do that?

You can set up an Inbox rule in Outlook to forward voice messages to another email account (for example, an assistant). By default, the forwarded message will also remain in your inbox. If you want to delete the message from your inbox, you can add that action to the rule.

1. In OWA, click Options, and select Create an Inbox rule....

10
2. Click the **New...** button. In the New Inbox Rule dialog box,

3. Click the **More Options...** button at the bottom of the dialog box.
4. Under **When the message arrives, and:**, click the drop-down arrow and select **It's**, and then **of the type**.... Select **Voice Mail**, and click **OK**.

5. Under **Do the following**, click the drop-down arrow and select **Forward, redirect, or send**, and then select one of the following:
   a. To forward the voice mail and leave a copy in your inbox, select **Redirect the message to**.... When the Address Book opens, select the person (or account) from the contacts list and click the **To ->** link, or type the contact's email address directly in the **To ->** field and click **OK**.
   b. To forward the voice mail without leaving a copy in your Inbox, select **Forward the message to**.... When the Address Book opens, select the person (or account) from the contacts list and click the **To ->** link, or type the contact's email address directly in the **To ->** field and click **OK**.

6. If you need to set exceptions, select the desired exception.

7. Click **Save** to save the inbox rule.

- **I don't want to use voice commands when I call my voicemail. How can I switch to the touchtone keypad interface?**

  To temporarily change from voice commands to touchtone commands, press 0. This change will only last for the duration of that specific call to voicemail. To change to touchtone commands permanently, dial into your voicemail and say "Personal Options", then press 4.

  Note: This does not turn off the voice prompts, only the speech recognition that allows you to speak your commands.

  To switch back to the Voice User Interface, dial into your voicemail and press 6 for Personal Options, then press 4.

- **How can I transfer a live caller directly to someone's voice mail?**

  Use the transfer feature on your telephone to transfer a live caller directly to voice mail:

  1. Press the Transfer key on your telephone.
  2. Dial 7027
  3. When you hear the recording, dial the ext of the person you are transferring the call to.
  4. Press the Transfer key again to connect the caller to the voice mailbox.